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DOCUMENT REVISION HISTORY

Revision | Date Description

2 10/17/14 | Maintenance release of 1.64 software (v.1.64.3.97)

1 4/30/14 | Initial release of 1.64 software (v.1.64.3.54)
INTRODUCTION

WeldHost is the software that runs on the ORBITMASTER welding control console. The
WeldHost team continues to add and improve features. These Release Notes document the
following aspects of version 1.64:

* New features

* Improvements

* Fixed defects

¢ Known issues

* Pre-installation evaluation of the equipment

* Installation instructions

* Instructions to re-install a previous software release
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WELDHOST VERSION 1.64.3.97

IMPROVEMENTS
* WH-592: Stop button initiated gas/coolant purging will now only purge the gas port/s used in

the weld program that is currently loaded. This will help prevent unintended gas
mixing/contamination. If no program is loaded, both ports will be purged as in previous
software releases.

o If one port is used in the program, that port will be purged.

o If two ports are used simultaneously, both ports will be purged.

o If two ports are used sequentially, the first port will be purged.

FIXES

 WH-1055: Updated weld head configuration parameters.

« WH-1084: Directories containing weld programs may now be deleted without first deleting all
programs in that directory.

* WH-1125: Standard track sizes up to 51.5” now available in the weld program editor track
size look-up table.

»  WH-1116/1126/1175/1243: Fixed miscellaneous Ul screen fragmentation/corruption issues.

* WH-1130: Added clarification in on how to select hardware settings in the System Protection-
>Hardware screen.

e WH-1131:

« WH-1136/1184: Performing a ‘cut’ operation on programs/directories now only deletes the
original files after it is pasted. This prevents data loss in the event that the user fails to
perform the ‘paste’ operation before the system losses power or is powered down. See
KNOWN LIMITATIONS under WELDHOST VERSION 1.64.3.54.

 WH-1138: User password entry is no longer required when upgrading sample weld
programs.

e WH-1141: A ‘copy’ operation may now be performed on a directory immediately prior to a
‘print’ operation on said directory without causing a system error.

* WH-1142: Wire/Tungsten touch fault now properly auto-clears when not welding.

* WH-1148: Fixed minor issue with display of RMD weld power setting program line.

*  WH-1149: The number of possible undo operations has been increased to 32.

¢ WH-1153: Crtl+P now prints properly from the library screen.

* WH-1155: Manual downslope before travel slope no longer locks up the pendant.

* WH-1158: Fixed heat input calculation problem for programs with both forward and reverse
travel directions.

e WH-1163/1165/1183/1207: Fixed miscellaneous weld program editor command line display
corruption issues.

« WH-1164: Fixed program corruption issue when un-protecting a weld program.

« WH-1168: Fixed issue where system would crash when selecting “What'’s this?” in the Weld
power menu.

«  WH-1169: Removed unused CV_AVC min/max settings from factory settings.

« WH-1170: Fixed system crash issue when trying to access a removed USB flash drive.

 WH-1172: Fixed problem with heat input not working with RMD.
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« WH-1179: Fixed problem with pendant settings not initializing correctly when adding
CV_AVC to older programs.

« WH-1190: Fixed a bug where canceling a rename operation can cause library screen
navigation issues.

«  WH-1194: “Weld program” and “Program notes” selections in the “What do you want to do?”
screen now work appropriately even after system power cycling.

 WH-1206: Performing an ‘undo’ operation from within a directory that was just ‘pasted’ no
longer causes a system crash.

« WH-1208: Heat input value is no longer corrupted after reasonably short weld program
execution time.

* WH-1212: Performing a ‘delete’ operation from within an empty USB flash drive no longer
causes a system crash.

 WH-1215: Coolant port 2 no longer selectable.

*  WH-1216: The ‘next program line’ command in a weld program no longer fails when the
invoked program name uses the maximum number of characters allowed.

*  WH-1217/1237: Excess/Insufficient current error threshold now the greater of 3A or 3%.

* WH-1219: Fixed system lockup issue when pressing Ctrl+F from “What do you want to do?”
screen.

« WH-1220: Fixed issue with incorrect downslope parameters used in some programs with
“looping” behavior.

e« WH-1221/1233: Fixed problem with some errors not displaying properly.

« WH-1226: Increased gas flow sensing delay from 3s to 5s.

« WH-1235: Fixed issue with dialog boxes displayed in the weld program editor/program notes
screens not drawing properly.

« WH-1245: Fixed crash when creating a program for a process not supported by the selected
weld power source.

* WH-1247: Fixed issue with undo being limited to 31 operations, not the specified 32.

e WH-1248: Fixed issue with programs corrupting when at the 99 line limit.

Numerous issues reported as fixed under 1.64.3.54 we missing from the actual distributed
release files. This has been addressed. Known issues follow:

e WH-960: Minimum allowed Dwell value for oscillation reduced from 0.1s (100ms to 0.01s
(10ms).

* WH-1087: Fixed an issue in which min/max limits were not functioning for gas or coolant
commands.

* WH-1097: Fixed an issue with port 1 not being the default when creating coolant commands.

 WH-1114: Fixed the issue with the Delete key being accepted as a valid password.

* WH-1125: More track sizes were added to the track size look-up table (weld program editor).

 WH-1139: Fixed an issue with performing downslope, in which a fault message is displayed
and an extra stop button press was required before you could start or resume the program.

e WH-1152: Fixed the issue with line 1 of a program not printing when multiple programs are
printed in the library screen.

« WH-1163: Fixed issue in which certain edit operations, performed on the process and track
type program lines, could cause the corruption of the weld program file.

* WH-1173: Fixed the issue in which a reboot was needed after the weld power source
configuration was changed to ensure that parameters are updated appropriately.
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* WH-1188: Entering indexing mode now requires a long (2s) button hold to prevent accidental
entry.

KNOWN LIMITATIONS
e RE: WH-1136/1184: The fix for this issue results in a slight change to the user interaction
when performing a ‘cut’ operation. Now, when a cut is done, a dialog box informing the user
that the cut item/s will be deleted once pasted will appear. This must be manually cleared by
the user. Note that improvements are scheduled for a future release to simplify this

operation.
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WELDHOST VERSION 1.64.3.54

NEW FEATURES

« AVC Sensing for FCAW and GMAW processes (ref #: WH-489).

Use weld current feedback/control to maintain contact tip work piece distance (CTWD) via
AVC Sensing in constant voltage (CV) programs (i.e. GMAW and FCAW).

i Weld pouer sensing f——
Weld power: IESHCEA

Advanced programming:
Response: 25_ %
Sensitivity: 100 #

Press ’Enter’ to proceed
Press 'Esc’ to cancel

New CV AVC command parameter entry dialog box (Program Editor: Movement->AVC
sensing—>Constant)

AVC overrides are performed like CC AVC programs. However, raising the torch in CC AVC
programs lowers the weld current (i.e. amps) whereas with CC AVC raising the torch raises
the voltage. Conversely, lowering the torch raises weld current.

| Pendant settings |

Jogs/steering options Override values

Jog distance [

Enter override values Change Maximum change
e — — 318 B A
Oscillation width 0.010_ in in
Travel speed- -—— 0.25__ inw/nmin in/nin
Uoltage 0.5 v - U
#wire feed——mm———————————"-m---—---voe— 2.0___ in/min in/min

New AVC pendant settings in CV programs (Program Editor: View—>Pendant Settings)
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 View factory sof tuare settings |
AUC sensing (GMAW-P/GTAW):

Feature Min Max Default Unit
FCAW/GMAW sensing:
High pulse-—- 15.0_ 425.0 A
IN Sidewall 15.0_ 425.0 A
0UT Sidewall-- 15.0_ 425.0 A
Cross-ueld 15.0 425.0 A

Press any key to proceed

AVC min/max limits and defaults for CV programs (Setup: Factory->View->Min/max
values>AVC sensing)

 Uiew factory software settings :
Arc gap settings:

Feature Min Max Default Unit
FCAW/GHAW :
AUC Response-—————- 0__ 30_ 20_ VA
AUC Sensitivity 0__ 100 100 A

Press any key to proceed

AVC min/max limits and defaults for CV programs (Setup: Factory—>View->Min/max
values—>Arc gap settings)
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Real-time Heat input calculation (ref #: WH-570).

The real-time display in the weld program editor now displays the cumulative heat input of a
weld in progress.

Heat input (in KJ/in) is updated in real-time and uses weld path data for the calculation. This
improves efficiency because no tape measure, power meter, or calculator is needed. The
calculation starts when the arc is ignited and stops when the arc is extinguished. When a
program is resumed, the heat input calculation starts from where it left off.

Real time data }

In Cycle Executing: 3FillPS Amps Travel Uolts Uire
Time: 37.7sec Line No: 12 Hi: 486.1 3.1ipm 26.2 121 .4ipm

Position: 21.71° Heat: 42.89kJ/in Low: 54.8 ipm 20.4 ipm

Heat input as displayed in the Real time data display

Miller Big Blue® 800 Duo Pro power source compatibility (ref # WH-1060).

Use the ORBITMASTER standard power source interface cables to use Miller's Big Blue®
800 Duo Pro engine powered weld power source/generator/air compressor with the
ORBITMASTER control console. Run up to four welding systems (when using two additional
weld power sources powered by Big Blue® generator outputs) from this machine without a
hardwired electrical supply.

Compatibility is limited to dual (A+B) operator mode and GTAW, GMAW-S and FCAW
processes.

1 System Protection |

Weld Head || Hardware

Select one from the following options.

Power source selection:

[ 1 Miller XMT 450

[ 1 Miller XMT 350

[X]1 Miller Big Blue 800 (A/B)
[ 1 Miller PipePro 450 RFC

Miller Big Blue® power source option (Setup: System->Protection—> Settings)
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| View factory software settings |

Hardware (All weld types):
AUC || Oscillation [ Weld power ] Travel || Weld head || Wire feed
Weld power limitations:
Feature HMin Max Default Unit
ID: BigBlue 800 A/B_ amperage 40.0_ 400.0 A
voltage 14.0 40.0 - v
Weld power source controller constants: Unit
F/GMAW voltage command D-to-A scaling 138.462 counts/V
F/GMAW command offset voltage 14.0 U
Output voltage A-to-D scaling 10.000_ counts/V
F/GMAW Inductance command D-to-A scaling 40.000_ counts/z
Weld current command D-to-A scaling 9.500__ counts/A
Weld current command offset current 20.0 A
Sensed weld current A-to-D scaling 32.000__ counts/A
GMAW-P CVU loop coefficients KCU1 1.8276__ KCUZ -0.8276_ N/A
KCU3 0.2088__ KCU4 0.0065__ KCUS -0.2020_ N/A
GMAW-P CV response scaling 1.000__ NsA
Ramp rate: 450 _ A/ms
Weldtypes supported on this power source:
[X1 FCAW [X1 GMAW [ 1 GMAW-P [X1 GTAW [ 1RMD

Miller Big Blue® 800 control parameters/settings (Setup: Factory->View->Min/max

values—>Hardware)
® 08
A
TN

=

Miller Big Blue® operator mode selector, set to dual operator

« RMD™ with Miller PipePro™ 450 RFC power source compatibility (ref #: WH-931).

Create and run RMD™ programs when the PipePro™ 450 RFC power source is selected. A
special power source interface harness (Tri Tool PN 79-0307) is required.
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i Yeld power settings |
U/ Trin : %

Press 'Enter’ to proceed
|| Press "Esc’ to cancel

RMD™ weld power settings command entry parameter dialog box (Program Editor: Weld
power->Settings)

] Pendant settings |

Override values

|

Jog/steering options || Jog distance [

Enter override values Change Maximum change
AUC 1.0_ V v
Oscillation width 0.010_ in in
Travel speed 0.25__ in/min in/nin
U/ Trin 0.1_ 7
WBire feed 2.8___ in/min in/nin

RMD™ process pendant settings (Program Editor: View—>Pendant settings)

 View factory software settings |
Pendant (amount of change allowed):

FCAW & GMAW GMAW-P n GTAW || Jogssteer speeds

Feature Min Max Default Unit
Weld power V / Trim ———————- 0.1_ 5.0_ . 7
Oscillation width 0.001_ 0.200_ 0.010_ in
Torch UP/DOUN 0.001_ 0.200_ 0.010_ in
Travel 0.10__ 3.00__ 0.25__ in/min
Wire 0.1__ 20.0__ 2.0 in/min
Steering increment:
Time (before continuous starts)-—— 0.1_ 10.0 0.5_ sec
Distance 0.010 0.200_ 0.010 in

Pendant min/max limits and defaults for RMD™ process (Setup: Factory—>View—->Min/max
values—>Pendant)

11| Page



1 View factory softuare settings }

Weld pouer (FCAUW/GMAW/RMD/GMAW-P):

Feature Min Max Pefault Unit

RMD settings:
U/ Trim 0.0_| 100.0 50.0_ -

Press any key to proceed

Power setting (V/Trim) min/max limits and default for RMD™ programs (Setup:
Factory->View->Min/max values->Weld power)

1 System Protection |

Hardware

|

Select one from the following options.

Weld Head [

Power source selection:

[ 1 Miller XMT 450

[ 1Miller XMT 350

[ 1Miller Big Blue 800 (A/B)
[X1 Miller PipePro 450 RFC

Miller PipePro™ 450 RFC power source option (Setup: System->Protection-> Settings)

1 View factory softuare settings |

Hardware (All weld types):

AUC || Oscillation [ Weld power “ Travel |I Weld head Il Wire feed

Weld power limitations:

Feature HMin Max Default Unit
ID: PipePro 450 RFC_ VU / Trimn 0.0__ 100.0 50.0_ 7
RMD VU / Trim DAC Scaling factor 40.59__ counts/z
RMD Wire speed to DAC (Volts) factor 0.0147_ counts/ipm

Weldtypes supported on this power source:
[ 1 FCAW [ 1 GHAW [ 1 GMAW-P [ 1GTAW [X1 RMD
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PipePro™ control parameters/settings (Setup: Factory->View—->Min/max values—>Hardware)

[a—
—
| —)

TO POWER SOURCE

TO WELD HEAD: AVC
TORCH SENSE

TO CONSOLE: AVC TORCH SE

Required power source harness (PN 79-0307)

« Date & Time settings are user accessible/configurable (ref #: WH-472).

Users may now set the system date and time and adjust the format. These features are in the
Setup screen under the Settings menu.

1 Setup |
[ Suston | ER
1
Curre| Date/Time >
Protection »| Settings | April 3, 2014
Reset calibration 7:17:43 AN
1 Time & Date |
System Time: [X1 Standard ry
Hour Min Sec [ 124 Hr Format
Y o 18 41 [X1AM [ 1PH
Systen Date: [X1 MM/DD/YY -
Month Day VYear [ 1 DD/MM/YY .
4_ 3_ 2014 [ 1YY/MM/DD
Press 'Enter’ to proceed 14
Press 'Esc’ to cancel 0:

Date/Time settings menu path and screen.

e Weld head configuration selection (ref # WH-1055).

Weld heads with different mechanical configurations are now supported. Enter the
configuration numbers for each axis as you update, revise, or reconfigure components.
Check the configuration settings when you connect a weld head to a console.

If aweld head is not marked with a configuration nhumber, use 00-00-00-00-00-00.
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1 Setup |

“ Systen “ Factory

Current Status
Date: April 3, 2014
Time: 16:41:11 AN
Language: English
Unit of Measurement: U.S. Customary
Available memory: 62.1 #

Hardware versions
™ -0S -AV - WF - MM
Weld Head Configuration No.: 00 - 00 — 00 - 00 - 00

Current configuration as displayed on the Setup screen.

1 System Protection |

[ Weld Head ] Hardware

TV-0S-AU - UWF - MM
Weld Head Configuration No.: 0_ 0_ 0_ 0_ 0_

Note: Travel calibration data will be reset
when you change the TV (Travel) configuration number.

Configuration settings screen (Setup: System->Protection-> Settings)

Configurable Gas/Coolant Sensor Feedback and Control (ref #: WH-1047, WH-1048).

If a gas or coolant sensor fails, it can be disabled to prevent work stoppage. You can disable
Cooler control to use a system with off-the-shelf coolers.

Warning: Disabling gas flow/coolant feedback defeats protections beneficial to weld
performance and system protection. Consult Tri Tool customer support before you do
this.
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1 System Protection |

Weld Head || Hardware

Select one from the following options.

Flow sensors setting:
[ 1 Disable gas flow sensor.
[ 1 Disable coolant flow sensor.

Console control settings:
[ 1 Disable coolant controls.

Sensor/control disable options (Setup: System->Protection—> Settings)

REMOVED FEATURES

Wire Reverse weld program command no longer supported (ref#: WH-855)

The Wire Reverse program command is no longer supported. Continuous reversal of wire of
a system with currently supported weld head configurations is not useful during welding and
can cause wire caging. Use Wire jogging to reverse wire direction manually.

IMPROVEMENTS

WH-388: Fault language improved when a touch/ignition command times out and when a
torch/tungsten up/down command is attempted while AVC Sensing is active.

WH-601: Fault language improved when current is commanded before the arc is established
via Ignition command.

WH-652: Gas and coolant flow are now required before an arc is established.

WH-960: Minimum allowed Dwell value for oscillation reduced from 0.1s (100ms to 0.01s
(10ms).

WH-679: Reversed weld power lead polarity now detected before arcing in GMAW-P.
WH-915: "Insufficient Current” fault now terminates weld program execution for all constant
current process types.

WH-933: When not welding, the Torch/Tungsten Touch fault is now displayed while touch is
detected. See the SPECIAL UPGRADE CONSIDERATIONS section for details.

WH-937: Console overheat fault now deactivates motor drives.

WH-941: Communication errors with motor/power controllers now generate a user fault.
WH-1011: The system now powers-up with wire feed disabled.

WH-1019: Pass size as small as 1.000" is now supported.

WH-1032: With the wire feed disabled (in-weld mode), MIG weld process program now
cannot be started.

WH-1082/1125: More track sizes were added to the track size look-up table (weld program
editor).
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* WH-1089: Pass/Track sizes as large as 999.999" are now supported.

* WH-1137: AVC Sensing now requires an arc to be established before executing. See the
SPECIAL UPGRADE CONSIDERATIONS section for details.

FIXES

e WH-272: Position real-time data now shows negative when the torch is on the left side of
starting position on flat tracks.

*  WH-325: Fixed the issue of not being able to override an oscillation command with zero
width.

 WH-535: Voltage and current average real-time values are now accurate for all processes.

e WH-648: Fixed the issue in which the GMAW-P trim override was not limited properly.

*  WH-803: Improved the detection of corrupted weld program files.

*  WH-850: GTAW high and low pulsation time is now limited to the duration of 1ms.

e WH-933: Miscellaneous improvements made to the handling of internal faults.

e WH-944: Fixed the display issue with Program Notes that occurs after they are entered from
the weld program while the start column is being edited.

* WH-957: Protected directories now retain their protection when being copied or moved.

*  WH-962:.When parameter protected programs are resumed; the overrides are now restored
properly.

* WH-968: Fixed the issue that occurs when copying a directory to a location where a directory
already existed in which files from the copied directory are dumped in the parent folder of the
destination.

*  WH-979: Fixed the issue of the travel motion not stopping when a polarity reversal fault stops
the program.

*  WH-992: Fixed the system freeze issue that occurred when Program Notes are viewed while
Real-time data is displayed in Weld Program Editor.

* WH-996: Encoder errors now deactivate the motor drives and prevent travel axis runaway.

e WH-999: Erroneous "AVC: Sensor Failure" fault is no longer triggered when very large AVC
Sensing corrections are made

¢ WH-1002: The Undo feature now works on changes of program line parameters.

*  WH-1005: Support was added for a more powerful AVC axis motor.

* WH-1012: Entering indexing mode now requires a long (2s) button hold to prevent accidental
entry.

¢ WH-1014: Fixed the problem in which stacked oscillation steers during oscillation would
cause the steer command to continue to the mechanical limit.

* WH-1015: Resume now appears in the program modifications log.

 WH-1016: Added a slight increase to the distance of the MIG wire burn back.

 WH-1018: Fixed the problem of incorrect program modification log current values occurring
when you change the configuration of the weld power source.

 WH-1030: Fixed the system freeze issue that occurred while editing a parameter protected
program in a password protected directory.

*  WH-1037: Fixed the display issue of closing a pop-up dialog box.

 WH-1046: Now multiple warning messages can stack on the console display.

* WH-1050: Fixed the display issue when editing an AVC Sensing program line while real-time
data is displayed.
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WH-1058: Fixed the problem in which viewing weld power source hardware factory
parameters causes the selected - power source to change.

WH-1061: When you specify delays in weld programs, you can now enter a capital "S" in the
start column

WH-1081: Minor changes were made to the program editor menus.

WH-1062: Fixed the display issue with stacked dialog boxes.

WH-1067: Fixed the display issue in which new weld programs were not navigable via
pendant until the directory was reloaded.

WH-1069: Fixed the system lock-up issue that occurred while performing a Cut in the library
if no program was selected.

WH-1070: Fixed the file issue in which blank program names were allowed, yet not
selectable.

WH-1072: GTAW ignition current is now limited by the minimum power source current.
WH-1087: Fixed an issue in which min/max limits were not functioning for gas or coolant
commands.

WH-1094: A weld program can no longer start if the motor power is disabled.

WH-1097: Fixed an issue with port 1 not being the default when creating coolant commands.
WH-1104: Fixed the system lock-up issue that occurred when Alt+Tab is pressed while the
factory settings are viewed

WH-1108: Fixed the system lock-up issue that occurred when Print Screen is pressed while
the pop-up dialog is open.

WH-1111: Fixed the interface issue in which you could not open the Program Notes by
highlighting the program in library screen and selecting Program Notes in the Screen Select
(Alt+Tab) menu.

WH-1112: Fixed the override issue in which overriding the pulsed travel could result in
different directions for each pulse.

WH-1114: Fixed the issue with the Delete key being accepted as a valid password.
WH-1115: Fixed the display issue that occurred when Backspace is pressed in an empty
password field.

WH-1119: Fixed the display issue of an erroneous "-" symbol being displayed when doing
wire overrides.

WH-1123: Fixed the control issue in which oscillation moves further than commanded when a
torch/tungsten move command was overridden in a previously run program.

WH-1139: Fixed an issue with performing downslope, in which a fault message is displayed
and an extra stop button press was required before you could start or resume the program.
WH-1152: Fixed the issue with line 1 of a program not printing when multiple programs are
printed in the library screen.

WH-1156: Fix the issue in which the oscillation could not be sloped from zero width.
WH-1163: Fixed issue in which certain edit operations, performed on the process and track
type program lines, could cause the corruption of the weld program file.

WH-1173: Fixed the issue in which a reboot was needed after the weld power source
configuration was changed to ensure that parameters are updated appropriately.
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SPECIAL UPGRADE CONSIDERATIONS

« Update/modification of existing GMAW-P programs that use AVC Sensing required
(IMPROVEMENTS: WH-1137).

New faults/safety checks require that an arc be established before AVC Sensing may be
activated.

o For GTAW programs this occurs at the completion of an Ignition command
o For GMAW-P (as well as all CV processes) this occurs at the completion of the initial
wire feed command.

Existing GMAW-P programs, in which the AVC Sensing program lines start before the wire
feed program line completes, will show the following fault after the AVC Sensing program line
is executed:

Program fault
Program line __ could not be executed because:

AVC Sensing not allowed with no arc established

In this release, Tri Tools sample programs, supplied with ORBITMASTER systems, were
updated. You must update the sample programs on customer systems when you install the
1.64 version. (see INSTALLATION INSTRUCTIONS). The following GMAW-P sample
programs were updated:

6Sc80T6GT+PS45\3FillPS
6Sc80T6GT+PS45\4CapPS
12Sc80T16GT+PS45\3FillPSFwd
12Sc80T16GT+PS45\3FillPSRev
12Sc80T16GT+PS45\4FillPSFwd
12Sc80T16GT+PS45\4FillPSRev
12Sc80T16GT+PS45\5FillPSINFwd
12Sc80T16GT+PS45\5FilIPSINRev
12Sc80T16GT+PS45\5FilIPSOUTFwd
12Sc80T16GT+PS45\5FilIPSOUTRev
12Sc80T16GT+PS45\6Cap(3Pass)

O OO0 O0OO0OO0OO0OOOOoOOo

Update user programs based on the sample programs of previous software releases. Update
GMAW-P programs, which use AVC Sensing, by modifying the AVC Sensing program line
start column to include the Wire Forward program line number as shown:

18| Page



y £

1 Weld Program |
Directory: None (root) Progran: 3FillPS

Progran " Edit " Flow " Weld pouer " Movenent " Wire " View

Line Start Action

1 Coolant: Port Number: 1 On

2 Rotate reverse: Speed: 20.00 in/min

3 . Rotation stop

4 Gas: Port Number: 2 On

5 ¥| 443s Weld pouwer settings: Current: High: 405.0 A Low: 50.0 A

b 5 Wire forward constant: Speed: 121.0 in/min

? Rotate forward: Speed: 50.00 in/min

8 iy Rotation stop
)3 | | AUC: Weld power sensing: Uoltage: 27.4 Upk 4
B 5 6 [ AUC: Ueld pover sensing: ______Voltage: 27.4 Upk___4

10 v Oscillation width: 0.180 in

11 Rotate reverse: Speed: 5.80 in/min

12 »v| 11 Rotate reverse: Speed: 2.90 in/min

13 | 360° AUC stop

14 i3 Weld power stop

15 14 Wire retract: Distance: 6.27 in  Speed: 268.8 in/min

16 Oscillation center stop

Tungsten/Wire Touched fault changes (IMPROVEMENTS: WH-933).

The Tungsten/Wire Touched fault now appears on the pendant whenever the welding
electrode touches the work piece. When not welding, the fault is only present while the
contact is detected, clearing when contact breaks. Previously, this fault appeared only during
welding.

Troubleshooting was added to the ORBITMASTER User Manual (Tri Tool PN 92-1250) so
users can easily verify proper weld circuit wiring, diagnose AVC sense cable failures and
power source lead inversions, and such.

Wire Reverse program command removal (IMPROVEMENTS: WH-855)

The wire reversal command was removed to prevent problems that occur when using the
weld program command on standard Tri Tool weld heads. Customers who made
modifications to their equipment that require the wire feeder to run in the reverse direction
may use existing programs with this command. However, the command is no longer available
in the program editor menu.

Encourage customers who are impacted by the removal of this command to contact Tri Tool
Customer Service.

Workarounds for creating new programs with this command include:
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o Copy a reverse wire program line from an existing program and paste it into new
programs.

0 Use "Save as" in the Weld Program Editor to make copies of an existing program and
modify it as needed.

« Weld program format update

New features in this release required changes to the format of the weld program files. New
programs created with this release cannot be edited or run on ORBITMASTER systems that
have older software revisions. When programs, created on older software revisions, are
edited with the new software revision, they are automatically converted to the new format.

KNOWN LIMITATIONS

« RMD™ is currently limited to Miller's PipePro™ 450 RFC power source, which is no longer a
present Miller product. Tri Tool is working on adding compatibility with the recent Miller
product.

* WH-1136: Cut files are lost if the system is powered down before the files are pasted.

ASSOCIATED MATERIALS/DOCUMENTATION

« WeldHost Software, PN 69-0150
¢  ORBITMASTER Manual, PN 92-1250
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SOFTWWARE INSTALLATION INSTRUCTIONS

BACK UP ALL WELD PROGRAMS BEFORE PERFORMING A SOFTWARE UPDATE.

Customers, who have multiple ORBITMASTER control consoles, must install the software
update on one system and verify that the issues, presented in the UPGRADE
CONSIDERATIONS section, do not cause problems before they update all of their systems.

Install the software update by doing the following:

1. Obtain installation files from your Tri Tool customer support representative.

2. Copy the following files/folders into the root (not a sub-folder) of a USB flash drive:
*  Weldhost.RTB
* Hostload.RTB
* Factr.dat
* Wprog (folder)

3. With the ORBITMASTER control console powered down, plug the USB flash drive into the
USB port that is on the top of the device.

4. Power-up the ORBITMASTER control console and wait for the system to boot. This will install
software onto the system.

Do not power down the system or remove USB flash drive until system boot-up is
complete.

5. Press the Escape key after the "What do you want to do?" screen is displayed to dismiss it.
Verify that the software version number displayed matches the update version number.

If software version number is not updated, ensure that the files are correct and are in the
USB flash drive root, and retry. If problems persist, contact Tri Tool for technical support.

6. Update the sample program files.

a. Navigate to the Weld Program Library.

b. Select "External memory".

c. Highlight all folders by highlighting the first folder, and then hold Shift down and

press the down arrow key until all folders are highlighted.

d. Select Edit>Copy (or press Ctrl+C) to copy the folders.

e. Select "System memory".
Select Edit>Paste (or press Ctrl+P) to paste the selected folders. This overwrites
the existing folders and the existing programs with updated programs.

—
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SOFTWARE ROLLBACK INSTRUCTIONS

Consult with Tri Tool customer service before you perform a Software rollback (re-installing a
previous software release).

Some software releases require changes to the weld program file versions. Therefore, programs
edited or created after the release is installed cannot be opened by older software releases. To
perform a software rollback do the following:

1. Obtain previous release installation files from your Tri Tool customer support representative.

2. Follow steps 2-6 in SOFTWARE INSTALLATION INSTRUCTIONS.

3. Copy any backup weld programs onto the system as described in Step 6 in SOFTWARE
INSTALLATION INSTRUCTIONS.

QUESTIONS OR PROBLEMS?

Contact Tri Tool Today

Toll Free: (800) 345-5015
Main Line: (916) 288-6100
Email: customer.service @tritol.com
Support Web Page: adaptarcsupport@tritool.com
Company Web Page: www.tritool.com
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